PROJECT DOCUMENTATION GUIDELINE

PERIODIC COMPREHENSIVE PROJECT REVIEWS

 SPD-REV-01A

Draft — May 28, 2004

Prepared by
Office of Information Technology
# TABLE OF CONTENTS

1 INTRODUCTION............................................................................................................ 1  
  1.1 PERIODIC AND OTHER REVIEWS.................................................................................. 1  
  1.2 SCOPE OF THIS GUIDELINE.......................................................................................... 1  
  1.3 SPONSORSHIP .............................................................................................................. 1  

2 THE REVIEW PROCESS .............................................................................................. 2  
  2.1 PURPOSE ..................................................................................................................... 2  
  2.2 ROLES AND RESPONSIBILITIES .................................................................................... 2  

3 AGENDA ..........................................................................................................................3  
  3.1 PROJECT OBJECTIVES.................................................................................................. 3  
    3.1.1 Institutional Issues Addressed by the Project .................................................... 3  
    3.1.2 Choice of Approach ........................................................................................... 4  
    3.1.3 Project Scope ..................................................................................................... 4  
  3.2 PROJECT ACCOMPLISHMENTS ..................................................................................... 5  
    3.2.1 Action Items from Previous Meeting(s).............................................................. 5  
    3.2.2 Current Status of the Project ............................................................................. 5  
  3.3 PROJECT FORECASTS................................................................................................... 5  
    3.3.1 Project Prognosis............................................................................................... 5  
    3.3.2 Risk Assessment.................................................................................................. 6  
  3.4 ISSUES AND OTHER BUSINESS ..................................................................................... 6  
    3.4.1 Project-Specific Issues ....................................................................................... 6  
    3.4.2 Stakeholder Issues.............................................................................................. 6  
    3.4.3 Institutional Issues ............................................................................................. 6  
  3.5 DECISIONS AND ADJOURNMENT.................................................................................. 7  
    3.5.1 Executive Endorsement ...................................................................................... 7  
    3.5.2 Review of Action Items....................................................................................... 7  
    3.5.3 Adjournment....................................................................................................... 7  

4 PREPARATION .............................................................................................................. 7  
  4.1 CONVOCATION ............................................................................................................ 7  
  4.2 PRESENTATION MATERIALS ........................................................................................ 8  
    4.2.1 Project Objectives .............................................................................................. 8  
    4.2.2 Project Accomplishments .................................................................................. 8  
    4.2.3 Project Forecasts ................................................................................................ 9  
    4.2.4 Issues and Other Business ............................................................................... 9  
    4.2.5 Briefing Book ................................................................................................... 10  
  4.3 PRE-MEETING REVIEW AND SUBMITTAL OF NEW ISSUES ......................................... 10  
  4.4 CALENDAR ................................................................................................................ 11
### APPENDIX A  THE BASICS OF EARNED VALUE ANALYSIS ......................... 12
- A - 1  THE THREE TRACKED COST ELEMENTS ........................................... 12
- A - 2  COST VARIANCE ........................................................................... 12
- A - 3  SCHEDULE VARIANCE ................................................................. 13
- A - 4  FORECASTING ............................................................................. 15

### APPENDIX B  EVA WITH MS-PROJECT AND EXCEL ........................... 20
- B - 1  SETUP STEPS ............................................................................... 20
- B - 2  STATUS UPDATE STEPS ............................................................... 22
- B - 3  FORECAST STEPS ....................................................................... 23

### APPENDIX C  MURPHY’S LAWS ............................................................ 25

### APPENDIX D  THE PROJECT ANALYZER ............................................ 26

### EXHIBITS
- EXHIBIT 1 – STANDARD REVIEW AGENDA ........................................ 3
- EXHIBIT 2 – COST VARIANCE ............................................................... 13
- EXHIBIT 3 – THE EVA PROJECT STATUS GRAPH ............................... 14
- EXHIBIT 4 – THE FIRST THREE WEEKS’ COST AND PERFORMANCE DATA 14
- EXHIBIT 5 – BCWS, BCWP AND ACWP AT THE THIRD STATUS DATE 15
- EXHIBIT 6 – PROJECT EARNED VALUE ANALYSIS SUMMARY ............... 17
- EXHIBIT 7 – BUDGET, ACTUAL COST AND ESTIMATE TO COMPLETE 17
- EXHIBIT 8 – PROJECT FORECAST WORKSHEET ................................. 18

### REVISION HISTORY

05/28/2004  Draft 1-B  For Review by SR Project
PERIODIC COMPREHENSIVE PROJECT REVIEWS

1 INTRODUCTION

Reviews are a component of the Project Development Flow process for high-impact campus-wide projects. This process attempts to insure that any project that meets the criteria of high impact and/or campus wide scope is fully socialized through all relevant committee structures and sponsorships prior to implementation, and that the campus remains aware of the status of these projects throughout their lifecycle.

1.1 PERIODIC AND OTHER REVIEWS

The manner in which a project reports progress and reviews status with its sponsor and the institution is normally documented in § 2.6 of its Project Control Document (PCD). The PCD always covers the obligations for operational reporting. The Project Development Flow also requires periodic strategic reviews of multi-year projects, whether or not these are specified in the project’s PCD.

Periodic comprehensive reviews validate the on-going relevance of projects to the Institution in terms of alignment with areas of strategic emphasis, availability of budgetary and other resources, and institutional strategies for technology deployment. The collective minutes of periodic reviews inform the Information Technology Planning Board’s (ITPB) Annual Portfolio Review.

1.2 SCOPE OF THIS GUIDELINE

This guideline provides project managers and reviewers with the essential agenda items for comprehensive reviews, the framework to prepare for such project reviews, and the suggested formats for presentation materials. Project managers may find some or all of these guidelines useful in structuring their operational reviews.

1.3 SPONSORSHIP

The Project Development Flow process has been established by the ITPB to authorize and monitor high-impact, campus-wide IT projects. These guidelines are part of the implementation of this process at the University.

These guidelines are maintained for the ITPB by the Office of Information Technology (OIT). The OIT issues updates as necessary to accommodate changes in the University’s operating procedures, in response to changes in technology, and as the result of practical experience with the review process and other campus feedback.

The most current versions of these guidelines and of the Project EVA template for Microsoft Excel are available for download from the PROCESS section at:

http://www.oit.ucla.edu/Documents

1 See: http://www.oit.ucla.edu/CommonDocuments/Process/Project_Development_Flow_Diagram.pdf
2 THE REVIEW PROCESS

2.1 PURPOSE
The annual review should be exactly that “a review.” The meeting should focus on decision making through a thoughtful review of the current facts and the assumptions about future directions. Periodic comprehensive reviews are not a venue to surprise the participants with major new issues or to debate implementation details with stakeholders.

Multi-year projects operate in changing regulatory, institutional and technical environments, requiring these projects to be redirected, however subtly, over time. Even if projects is operationally entirely on track—i.e., it meets all budget and schedule commitments—it may no longer be on track from a strategic perspective. Formal periodic reviews provide institutional decision makers an opportunity to reflect on the strategic alignment of projects in a systematic fashion and, when necessary, to redirect projects to achieve better alignment of project objectives with institutional needs.

2.2 ROLES AND RESPONSIBILITIES
In the context of a project:

- Project managers are accountable for the execution of their projects. They manage day-to-day tasks and are expected to work closely with the project’s functional sponsors to insure ongoing relevance of their work product to the sponsor’s operations.

- Functional sponsors are responsible to monitor the continued relevance of projects to their operations and to work with the project manager to insure that needs are met in timely and responsive fashion.

- Executive sponsors have fiduciary responsibility for the funds applied to a project and are expected to periodically review the alignment of projects with their strategic priorities.

- The Committee on Information Technology Infrastructure (CITI) is responsible for strategic and tactical planning, operational policy, and business and cost allocation models. The CITI is appointed by the Executive Vice Chancellor on behalf of the Deans and Vice Chancellors and members are academic and administrative directors responsible for business and fiscal aspects of IT applications and infrastructure.

- The ITPB informs and advises UCLA’s executive management and Senate leadership on information technology, including budget and policy matters, and strategic opportunities regarding investment in and deployment of information technology.

- The OIT, supported by the Common Systems Group (CSG)², provides technical expertise to inform the ITPB and executive decision makers, manages the institutional IT planning process, and oversees institutional outcomes of information technology initiatives.

At the review project manager and, optionally, functional sponsors present a recap of the project goals, report progress to date, bring up relevant technology issues and give their risk assessment at a level of aggregation appropriate to an executive audience.

Members of the audience who have a financial or operational interest in the project—either because their IT systems do, might, or should have interfaces, or because the project affects business processes for which they are responsible—are expected to reassess the impact of their operations on the project.

---

² The Common Systems Group is UCLA’s technical focal point for systems infrastructure, support and standards that involve coordination campus wide. For more information see: http://www.csg.oit.ucla.edu.
as well as understand the consequences of the current status of the project for their present and future operational plans.

The OIT will normally supply the chairperson to moderate the review and the recording secretary to document the discussion. Meeting minutes are part of the formal project documentation; they will be circulated for comment, revised as appropriate and distributed to all participants in final form. Project managers shall include a copy of these minutes in the project notebook.

3 AGENDA

The agenda for the meeting will generally follow the following sequence of topics. The agenda may be tailored to accommodate the circumstances of a particular project or to allow project-specific or unusual issues to be addressed. See § 4.3, Pre-Meeting Review and Submittal of New Issues, for the process of adding items to the agenda.

<table>
<thead>
<tr>
<th>REVIEW AGENDA</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project Objectives</strong></td>
</tr>
<tr>
<td>Institutional Issues Addressed by the Project</td>
</tr>
<tr>
<td>Choice of Approach</td>
</tr>
<tr>
<td>Project Scope</td>
</tr>
<tr>
<td><strong>Project Accomplishments</strong></td>
</tr>
<tr>
<td>Action Items from Previous Meeting(s)</td>
</tr>
<tr>
<td>Current Status of the Project</td>
</tr>
<tr>
<td><strong>Project Forecasts</strong></td>
</tr>
<tr>
<td>Project Prognosis</td>
</tr>
<tr>
<td>Risk Assessment</td>
</tr>
<tr>
<td><strong>Issues and Other Business</strong></td>
</tr>
<tr>
<td>Project-Specific Issues</td>
</tr>
<tr>
<td>Stakeholder Issues</td>
</tr>
<tr>
<td>Institutional Issues</td>
</tr>
<tr>
<td><strong>Decisions and Adjournment</strong></td>
</tr>
</tbody>
</table>

Exhibit 1 – Standard Review Agenda

3.1 PROJECT OBJECTIVES

3.1.1 Institutional Issues Addressed by the Project

If the institutional context of the project is familiar to the reviewers and no new issues have arisen prior to the review, the project manager can present this summary. If not, this context may better be provided by the project’s functional sponsors, since they “own” the institutional issue(s) that the
project seeks to remedy and will have to address the reviewers’ questions in this and subsequent segments of the agenda.

- A short overview of the institutional issue(s) addressed by the project. Project objectives are most often stated in terms of an operational need that is not, or not adequately, being met by the status quo, but they may be purely technical, e.g., replacement of a major legacy system that is no longer supportable.

- A short review of the changes in “process” that are expected to result from implementing the project. “Process” is used generically, that is, it may refer to a business, educational, or research process or to a change in behavior, perhaps of an external entity.

### 3.1.2 Choice of Approach

This segment should present a short review of the assumptions and decisions made by the functional and technical stakeholders to converge on the specific parameters (scope, schedule, etc.) of the project. It should answer questions such as:

- Who are the sponsors and what constraints did they place on the project? Did material schedule or budget constraints shape the project? Are/were there constraints on selection of vendors? Are there collaborating institutions, etc.?

- Who are the stakeholders? How are they included in the project? What are the major impacts they have on the project? How are they affected by the project?

- Who else was consulted in framing the project and what were their contributions? For example:
  - Do other universities have the same issue(s)? How are they addressing them? (Note that the status at peer institutions at the start of the project may be quite different than at the time of the review. If so, discuss the implications, if any.)
  - Did external consultants assist in framing the issues or developing the solution?

### 3.1.3 Project Scope

- A brief overview of the scope of the project. What was originally included in the project and, if appropriate, what was excluded? What changes in scope have been made since its inception?

- A brief overview of the way in which the project is being managed.
  - Is it a “traditional” waterfall, a rapid prototyping model, or …? Why?
  - What are the project phases? Are you using a single design/build/test/deploy cycle? A JAD conceptualization phase followed by a 3-pass elaborate/test/deploy cycle? Or …? Why?
  - Were any changes in lifecycle model made since the project’s inception? Why?

- A brief overview of the technical architecture for the project. What factors or assumptions shaped the choice of this particular hardware, software, vendor, etc.?

- What, if any, changes in the university’s data model have to be made as a result of the project. Highlight the implications outside the project; these are of most concern to the reviewers.
3.2 PROJECT ACCOMPLISHMENTS

3.2.1 Action Items from Previous Meeting(s)
Before giving a report on the status of the project, acknowledge status of action items from previous review(s), if any. If the action items pertain to a topic that will come up for discussion at a later time on the agenda and the action item will be addressed then, state that fact. Otherwise, discuss the action item(s) at this point to complete unfinished business from earlier meeting(s).

- Discuss disposition of action items closed since the last meeting.
- Identify action items still open and report on their status.

3.2.2 Current Status of the Project
This segment gives an accounting of benefits that the University has received from the project thus far and compares these with the project plan. Review project status against the approved plan and budget:

- Summary of deliverables produced and milestones completed.
- Financials and explanation of variances. (Discuss sources as well as use of funds.)
- Resolution of significant technical issues and/or important decisions made.

This segment is most effectively supported with high-level Gantt charts, “dashboard” illustrations and earned value analysis. (See Appendix A, The Basics of Earned Value Analysis.)

3.3 PROJECT FORECASTS
The emphasis of the meeting now shifts to the future. Reviewers are expected to play an active role in the remainder of the meeting. In this segment, the audience will react to the prognosis for the project and will validate the relevance of the future benefits of the project to the University. Changes in stakeholders’ needs, project urgency and/or relative priority are brought up.

3.3.1 Project Prognosis

- Project manager’s outlook for the project:
  - Summary of deliverables to be produced and the functionality that these represent.
  - Updates to schedule and discussion of related budget or other resource needs.
  - Major issues to be resolved or critical decisions to be made.
- After the project manager gives the prognosis for the project, the executive and functional sponsors have the opportunity to express continued support for the project and, where necessary, redefine their expectations for the project. For example, the project’s value to the institution or the level of urgency may be discussed, and/or budget commitment can be commensurately adjusted up or down.
  a) Functional sponsors formally express their support for the project.
     i) Changes in need, urgency, priority, budget commitment, etc. are formally noted and recorded in the meeting minutes.
     ii) Depending on the phase of the project, functional sponsors will present plans for institutional deployment.
• If sponsors are planning significant project changes or to drop sponsorship of the project, they will inform the project manager ahead of the review. The project manager will present the alternative scenarios or shutdown plan for consideration during this segment of the review.

b) Other stakeholders have the opportunity to express their assessment of the project and their concurrence with the project plan. Their support may be conditioned upon the satisfactory resolution of open issues.

• Significant redirection of a project by its sponsors will always cause the assignment of further action items: the impact on other stakeholders must be considered in such decisions, as it is in the decision to start a project.

3.3.2 Risk Assessment
In this segment the project manager presents an updated risk assessment for the project. Meeting participants have the opportunity to speak to areas of concern. If new issues are uncovered during this review, action items to address these will be assigned.

• Project manager reviews the assumptions in the PCD and those added in previous reviews, and reports on the results of the risk mitigation strategies.

• Project manager presents proposed or *de facto* changes in risk mitigation strategy.

• Project manager highlights newly identified schedule, technical or financial risks and their mitigation strategies.

Sponsors must, and stakeholders may, comment on the project manager’s assessment. Sponsors may assign further action items as a result of the risk assessment.

3.4 ISSUES AND OTHER BUSINESS

3.4.1 Project-Specific Issues
This agenda item provides a placeholder for reports or discussion required by special circumstances: relevant institutional issues, encumbrances or covenants of a particular program or funding source, or any other factor that may have a material impact on the project or its outcome.

3.4.2 Stakeholder Issues
Stakeholders may have issues related to the project’s execution, changes in scope or schedule, or the deployment of its deliverables. Issues that are not under the control of the project manager may affect the reviewers’ assessment of the project’s strategic relevance, the need for funding, or the scheduling of its deliverables.

3.4.3 Institutional Issues
If appropriate, the chair of the ITPB or designee provides an assessment of the degree of alignment of the project with the university’s strategic information technology initiatives. This item may also set, if needed, the context for any decisions to redirect the project.
3.5 DECISIONS AND ADJOURNMENT

3.5.1 Executive Endorsement
Executive sponsors formally express their support for the project, including their ability to provide the requisite financial resources, and offer any further perspective resulting from the Project Prognosis and Risk Assessment segments and/or any project-specific or stakeholder issues brought up.

If such support is not given or is conditioned upon the resolution of any issue:

- Action items to prepare for reaching a decision will be assigned.
- An adjourned session of the review will be scheduled. Depending on the nature of the issues to be resolved, the adjourned meeting may be a face-to-face meeting or may be conducted via correspondence. In the latter case, the correspondence will serve as the minutes of that “meeting” and project manager will include all such correspondence with other review minutes in the project notebook.

3.5.2 Review of Action Items
The recording secretary reviews the list of action items or other follow-up activities that have resulted from the review.

3.5.3 Adjournment
- The “project champion” has the opportunity to make closing remarks.
- The Vice Chancellor, Information Technology, may offer closing thoughts.
- The meeting moderator makes any final announcements (e.g., future meeting dates for an adjourned session, etc.).

4 PREPARATION
A periodic review should require little additional work from the project manager. All supporting data should be available as part of the day-to-day management of the project. Reviewers are expected to be familiar with the contents of the project control document (PCD) and minutes of previous reviews of the project. Advance copies of presentation materials will be made available prior to the meeting and, in response, participants may request items to be added to the agenda and to submit written questions.

4.1 CONVOCATION
Unless this is an “emergency” review, be sure to get an early start on scheduling the meeting. The periodic comprehensive review involves many high-level—that is, hard to schedule—individuals. A 2–month lead time is not unreasonable. Not only do you want people to show up, unless you want to answer a lot of background questions, you want to have them come well-prepared. (See § 4.4, Calendar.)

The OIT will handle the mechanics of scheduling the review and notifying reviewers of the agenda and availability of other materials. The project manager shall notify OIT of any new business items that the project will introduce in the Project-Specific Issues segment at the time the meeting is scheduled.

Once the meeting is scheduled, make sure that the information to be presented as well as background materials (PCD, earlier review notes, etc.) are distributed. It is increasingly common to do this via an
e-mail with a link to a project website. Be sure that the documents are downloadable in PDF or DOC format. Many reviewers do not have the ability to open Visio drawings and MS-Project files, not to mention the files generated by software design and development tools. Gentle reminders to review the materials, particularly if there are no hits on the project web site, may be in order.

### 4.2 PRESENTATION MATERIALS

Do not assume that you will have network access in the meeting room, even if you have tested it. Connections only fail during “real” meetings 🚨. Make a copy of everything you may need on your laptop or, if you use a venue-provided computer, on a USB “key drive.”

#### 4.2.1 Project Objectives

The core information for this segment is contained in the project’s project control document (PCD), but there may have been small updates—“small” meaning in this context that no updated PCD was issued as a result of the changes.

1) You can reasonably expect the reviewers to be aware of the general nature of the project, but they will need a refresher on who is involved and on the full scope of the project’s impact on the university. It is typically sufficient to summarize the *Institutional Issues Addressed by the Project* in one or two PowerPoint slides: a succinct one-liner stating the major thrust of project, and a couple of bullets on its impact on the campus.

2) In *Choice of Approach* bring your audience quickly up to speed on who the sponsors and other stakeholders are. Focus on what the sponsors bring to the party and how the project interacts with the stakeholders to keep them informed and/or to fund modifications to their systems. It is quite effective to show changes by starting with the slide from the last review then overlay it with the new information.

3) Multi-year projects are invariably subject to change; use the same technique to highlight changes in the *Project Scope* segment. Show what has changed in the hearts and minds of the sponsors: What was dropped and why? What was added and why?

4) If the reviewers do not understand how you manage the project, they will ask many questions about what you are doing. Be proactive: include a slide on the lifecycle model you are using—maybe two, if the model you use is likely to be unfamiliar to the reviewers—and explain why the choice is best for the type of project. Or, if it isn’t, why you are changing to something that works better.

5) Also, remind the audience of the technical architecture: they may remember that you are doing something unusual, but they are not likely to remember why. Reviewers will usually be acutely aware of the costs they will incur to modify their legacy systems or replace their departments’ desktop machines. It is advisable to refresh their memory—at the appropriate level of detail for a non-technical audience—on the reasons they have to do this if you wish to have their continued support.

#### 4.2.2 Project Accomplishments

Collect the latest edition of your project status reports into a briefing book. Keep the audience in mind; data presented should be at a fairly high level of aggregation. Bring your own, more detailed, data as reference and be prepared to discuss the data and the tools you use to control the project.³

---

³ Two excellent contemporary though pricey ($80 each) reference works: *Project Management ToolBox: Tools and Techniques for the Practicing Project Manager*, by Dragan Z. Milosevic (600 pages) and, with 912 pages
What should be included in this segment beyond milestones, deliverables and project financials (EVA) will depend on the specifics of your project.

1) A good idea is to start with the milestones and deliverables table from the PCD. This is a succinct way to show the value derived from the project thus far. If you are using an “unfamiliar” development methodology, you may need to explain the deliverables. Only fellow-geeks will know what an entity-relationship diagram, a consolidated logical data model or a use case elaboration is. If your executive sponsors aren’t convinced that these deliverables are “a good thing,” they may not continue to fund your project.

2) At the executive level few tools are as effective to communicate project status as the earned value analysis and a forecast based thereon. (See Appendix A, The Basics of Earned Value Analysis for a discussion of the fundamental EVA concepts and Appendix B, EVA with MS-Project and Excel, for an example of using the Project EVA template.) If useful, augment the project summary graph with detail in the form of “traffic lights,” dashboards, sliders or whatever your favorite graphic fancy may be.

3) Present the data with your analysis and explanation of the variances in cost and schedule. Cover each topic (e.g., resource problems, scope creep, legislative changes) on a separate slide; this helps focus the discussion and makes the materials understandable for reviewers as they prepare for the review.

4.2.3 Project Forecasts

The earned value analysis graph presented in the Project Accomplishments segment provides a starting point for presenting your project forecast. If the forecast does not follow the project’s past trend, give a detailed explanation of the reasons for the changed project behavior and the probability of attaining it. (See also Appendix Section A - 4, Forecasting, pg. 15 et seq.)

Make use of the project control tools that you use to track artifacts, bug fixes, features per build, or any other metrics you routinely track to support your forecast. Even if you only update your project monthly, you should have sufficient data to provide statistical information to support your forecast. (See Milosevic op. cit. for formal statistical methods such as CPI control charts, etc.)

You may not want to include all the details in your presentation materials, but if your presentation is in PowerPoint, you may want to include links to the detail data. That way, when questions arise, you will be able to “drill down” by clicking on the relevant item. If not—such complex presentations may be more work than they are worth—be prepared to switch to your management reports on the fly.

4.2.4 Issues and Other Business

This agenda item, in which sponsors and stakeholders provide input to the project, normally requires little preparation on the part of the project manager. The notable exceptions are when sponsors intend to redirect the project significantly or when the project manager brings up project-specific issue to be addressed by the review panel.

- Project-Specific Issues are unique to the project and its continued successful execution but outside the scope of the standard review agenda or best handled as a separate item of

the even thicker, Project Management: A Systems Approach to Planning, Scheduling, and Controlling by Harold Kerzner. Both come in hardcover only and were published in 2003 by John Wiley & Sons.

4 Remember that the EAC as calculated by Microsoft Project assumes that work not completed will be performed exactly as planned, independent of the project’s track record. A more useful forecast for software development projects based on MS-Project provided values is EAC = BAC – VAC, both. (See also Appendix A - 4, pg. 16.)
business. The project manager should see to it that these issues are included in the agenda (see also § 4.1, Convocation, pg. 7).

- **Stakeholder Issues** are items of business that are outside the scope of the standard review agenda but relevant to the project, including its implementation phase. Project managers may need to prepare to respond to these issues if they affect resources within their control or as directed by their sponsors.

- The **Institutional Issues** segment is provided for a review of the project in the context of institutional strategies for deployment of information technology. This item sets the stage for any further comments by the executive and/or functional sponsors in the final segment of the review. Project managers may need to prepare to respond to these issues if they affect the direction of their project or as directed by their sponsors.

### 4.2.5 Briefing Book

Traditionally paper copies of presentation materials and other handouts have been prepared for use at review meetings in addition to the materials provided electronically either by posting on a web site or as an e-mail attachment. When reviewers download these materials and mark them up for use during the review session, providing the complete set of hardcopy materials at the meeting may not be required or even desirable.

It is not unreasonable to limit paper at the meeting to a list of reviewers with their affiliation, a current agenda—there may be last minute changes—and any materials that may reasonably be expected to be “new” to the reviewers, e.g., an up-to-date project status or financial report. (Such documents should, however, be made available in electronic form following the meeting so participants can update their electronic files if they so desire.)

Whether the “briefing book” is electronic or paper, the following should be included:

- a) Meeting Agenda
- b) List of Reviewers and Their Affiliations.
- c) Presentation Materials in the Order of Presentation.
- d) Responses to Formal Questions by the Review Panel. (New issues should be included the point where they are placed on the agenda.)
- e) (Pointers to) Formal Project Documentation (e.g., Project Control Document, Gantt charts, Status Reports.)
- f) (Pointers to) Other Relevant Documentation (e.g., Gartner Studies, EDUCAUSE publications, web sites at peer universities.)

### 4.3 PRE-MEETING REVIEW AND SUBMITTAL OF NEW ISSUES

Members of the audience who have a financial or operational interest in the project—either because their IT systems do, might, or should have interfaces, or because the project affects the way in which they conduct their business—are expected to reassess the impact of their operations on the project as well as understand the consequences of the current status of the project for their present and future operational plans.

The project manager provides reviewers with the project’s current status and forecasts and a current risk assessment (see § 3.2, 3.3.1, and 3.3.2) and other relevant documentation approximately 4 weeks prior to the date of the review.
To facilitate an efficient review, reviewers should provide the meeting moderator within 2 weeks with written questions and/or position statements if more than a simple clarification is needed or issues not currently on the agenda are to be raised. The OIT will distribute these comments and the project manager’s analysis to the review panel in the week prior to the meeting.

Sponsors and stakeholders may request OIT to place additional matters on the agenda under the *Issues and Other Business* rubric. The requester shall submit the request with a written description of the matter to be considered and the expected action thereon to be taken by the project manager and/or the review panel. This information will be made available to all participants in the review prior to the meeting.

### 4.4 Calendar

Formal preparations for the review typically start 8 weeks prior to the proposed review date. The final date will be determined as part of the following activities. The Office of Information Technology will assist the project manager in scheduling the review.

- **8 weeks before** — OIT and project manager identify members of the review team. (A good review team will typically include one or more external reviewers). OIT invites the proposed individuals to participate in the review.

- **8-6 weeks before** — OIT works with proposed review team to schedule a review date. OIT, in consultation with the project manager, reserves a conference room or other facility with sufficient seating capacity and such other facilities as may be appropriate for the review.

- **5 weeks before** — OIT works with the project manager to identify and collect appropriate documents to be distributed to review team.

- **4 weeks before** — OIT distributes the documents (via e-mail or by a pointer to web site) to the review team. OIT notifies appropriate IT committees of the review date and distributes the documents (electronically or by supplying a URL) to these committees. Reviewers are expected to comment on the documentation within 2 weeks of it being made available.

- **2 weeks before** — Requests for clarification or more information, etc. from the review team are due at OIT. OIT forwards the requests to the project manager and works with the project manager to develop responses, finalize the agenda, and finalize what documents are to be included in the briefing book (handouts) for the meeting. The project manager is responsible for preparing answers to questions and preparing and providing handouts to the review team on the meeting day.

- **1 week before** — OIT distributes (electronically) the final agenda and the project manager's responses to questions.

- **2 weeks after** — OIT distributes meeting minutes and other documents as required.

- **1 – 12 months after** — Project manager notifies OIT and review panel of action items resolved. If an adjourned session was agreed to, the meeting will be scheduled when necessary information is available or prerequisite action item has been completed.
APPENDIX A  THE BASICS OF EARNED VALUE ANALYSIS

Earned value analysis (EVA) provides the project manager a set of powerful control tools. All project plans are in some sense a tradeoff between schedule, features and budget. EVA provides a formal way to evaluate costs and forecast project performance.

1) It compares actual project performance (deliverables produced and their actual costs) against what was planned (expenditures budgeted for these deliverables) to determine how well the project is being executed.

2) It allows one to readily disaggregate cost variance from schedule variance. (Projects will always appear to be on budget if a fixed number of people work on a project and monthly expenditures are tracked only against labor budget. Adding deliverables into the analysis, one can determine whether the project is in actuality underspending or overspending compared to the project plan.)

3) The analysis can help develop the forecast for the final cost of a project (Estimate at Completion [EAC]) or, conversely, show the project manager when to modify execution of the project plan to achieve its objectives.

A - 1  The Three Tracked Cost Elements

These techniques are in such common use that a standard vocabulary has developed to identify tracked cost elements. Microsoft Project and most other project scheduling tools have built-in support for Earned Value Analysis. (See 0.)

- **Budgeted Cost of Work Scheduled (BCWS)**
  This is the total of all budgeted costs for all work scheduled to be accomplished—whether actually performed or not—up to the “status date,” the point in time (often the end of a fiscal period but it can be any arbitrary point in time) for which the analysis is done.

- **Budgeted Cost of Work Performed (BCWP)**
  This is the total of all budgeted costs for all work that was actually performed up to status date. BCWP is the “value” of the work performed—not unreasonable since it was used in that sense to justify the project originally.

- **Actual Cost of Work Performed (ACWP)**
  This is the total of the actual cost for all the work included in the BCWP.

These three variables are enough to give us a top-level picture of the health of a project. Although Earned Value Analysis uses cost as the metric, cost is, in some sense, just another way of tracking labor hours. Tracking cost instead of labor hours is important because you also have to worry about a project’s budget. If the actual hourly labor costs are higher than what is in the plan, you will have a budget problem even if the number of hours worked is exactly as planned…

A - 2  Cost Variance

The first thing a project manager usually worries about is budget. So the first step for us is to measure whether we are on budget as of the Status Date, the time for which the analysis is being done. How close are we? The performance metrics are:

- **Cost Variance \[CV = BCWP - ACWP\]**
  This metric answers the question: Are we under or over budget? If the actual cost of the work performed is larger than the budgeted cost of that work, the project is over budget and \(CV < 0\).
**GUIDELINES FOR PERIODIC COMPREHENSIVE PROJECT REVIEWS**

- **Cost Variance Index** [CVI = CV / ACWP]
  This metric gives the rate by which you are over or underspending your budget.

- **Cost Performance Index** [CPI = BCWP / ACWP]
  This is the rate at which cost is actually accrued compared to what was planned for those tasks. This metric of past performance is also used in forecasting. CPI is < 1 if you are running over budget.

If we assume for the moment that the project is on track—that is, all work scheduled, no more and no less, was performed—we have a situation as depicted in Exhibit 2. At Status Date the cumulative budgeted cost of work scheduled (BCWS) and that of work actually performed (BCWP) are the same, and we can use that cost curve as the baseline against which to measure project progress.

**Exhibit 2 – Cost Variance**

This, of course, is project manager’s dream: the project is on schedule and under budget. Great is therefore the temptation to compare budgeted expense (BCWS) to actual, congratulate oneself on a job well-done, and stop. Ah…! But what if not all work scheduled was completed? In other words, what if BCWP does not equal BCWS?

**A - 3 Schedule Variance**

What if only part of the (cumulative) deliverables were realized? Then, we are behind schedule or, as accountants say, we have an unfavorable schedule variance. This leads to three more metrics:

- **Schedule Variance** [SV = BCWP – BCWS]
  If more work was scheduled than was performed (SV < 0), you are behind schedule.

- **Schedule Variance Index** [SVI = SV/BCWS]
  This metric is the amount, expressed as a fraction of what should have been accomplished, by which the project is ahead of or behind schedule.

- **Schedule Performance Index** [SPI = BCWP / BCWS]
  The ratio between the (cost of the) work performed to that scheduled. Expressed as a percentage it is the familiar “% complete” statistic.
The concept of a schedule variance in dollars may be unfamiliar, but as is shown in Exhibit 3, one can be “behind schedule” in dollars—even while at the same time over budget in terms of work actually performed—and, given the expected spend rate (BCWS curve), dollars are easily converted to months.

Exhibit 3 – The EVA Project Status Graph

To see how this works in practice, let us look at a “real” project during its first three weeks. The first task—Week 1—is to get the team organized. Although the person assigned the task works the entire week, at the end of the first week it turns out that two more days of work are required to complete the task. In the next week, the project not only catches up but gets a little ahead of schedule. In the third week the project gets back on track. The results of these first three weeks are tabulated in Exhibit 4.

<table>
<thead>
<tr>
<th>Week</th>
<th>Status Date</th>
<th>BCWS</th>
<th>BCWP</th>
<th>ACWP</th>
<th>CV</th>
<th>SV</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1/31/2004</td>
<td>$2,400.00</td>
<td>$1,714.20</td>
<td>$2,400.00</td>
<td>($686.80)</td>
<td>($686.80)</td>
</tr>
<tr>
<td>2</td>
<td>2/7/2004</td>
<td>$3,360.00</td>
<td>$3,411.40</td>
<td>$4,440.00</td>
<td>(1,028.60)</td>
<td>51.40</td>
</tr>
<tr>
<td>3</td>
<td>2/14/2004</td>
<td>$4,400.00</td>
<td>$4,440.00</td>
<td>$5,400.00</td>
<td>(960.00)</td>
<td>0</td>
</tr>
</tbody>
</table>

Exhibit 4 – The First Three Weeks’ Cost and Performance Data

Let’s assume a labor rate of $60.00/hr. In Week 1, in which 40 hours of work is to be done, we had originally scheduled $2,400 of work (BCWS). A labor charge of $2,400 was incurred (ACWP), but is the project on track? What was actually accomplished? The first week’s task was estimated at 40 hours, but will actually take 2 more days (16 hours). So we have only accomplished 71.4% of what turned out to be a 56-hour task; the value realized (BCWP) is only 71.4% of the budget ($1,714.20). Although we spent exactly the $2,400 budgeted, we are in fact 28.6% over our budget. In this special case we are also 28.6% behind schedule—normally the ACWP and BWCS will be different.

Not much work was scheduled in the second week of the project, so the extra two days are made up in Week-2 and about an hour more work is done than was scheduled (BCWP > BCWS). In the third week the project is completely on track (BCWS=BCWP). The schedule variance is gone, but the cost overrun stays: after three weeks the project is over budget by $960 (ACWP – BCWS)—the cost of the extra 16 hours. While the narrative is useful, Exhibit 5 makes the cost implications immediately clear.
Most project management systems make this analysis relatively easy by saving the original (baseline) budget (BCWS) and calculate the BCWP and ACWP\(^5\) for the status date when you update the project. (See also Appendix B, *EVA with MS-Project and Excel*.)

### A - 4 Forecasting

In the previous section you found out whether you are spending too much or too little, and whether or not you are ahead of or behind schedule. Reviewers are usually also very interested in knowing where the project will end up. To do that we use the following metrics, with their standard terminology:

- **Budget at Completion [BAC]**
  
  The “Budget at Completion” is the original total cost approved for the project plus (minus) any budget changes that were approved. It is the total budget *authorized* for the project, which is not necessarily what the project will need to complete the work.

- **Estimate at Completion [EAC]**
  
  The “Estimate at Completion” is the project manager’s current forecast for the project’s total cost. The simplest estimate is to assume that independent of what the project’s performance has been thus far, it will execute exactly according to plan in the future. This leads to the following estimate:

  \[
  \text{EAC} = \text{ACWP} + (\text{BAC} - \text{BCWP})
  \]  

\(^5\) Although scheduling programs will calculate ACWP based on standard rates, using data from a cost accounting system together with standard rate costs gives you better control of your budget: it makes the labor component of cost variance explicit.
The final cost of the project is the actual cost plus the cost of the work not yet done. In a software project this is unlikely to actually happen unless some dramatic change has taken or will take place. Otherwise, why would the project suddenly perform differently? It is not a bad model for a construction project: if there was a problem pouring the foundation, there is no reason to assume that the plumber will also have a problem.

 différements.  Il est donc une mauvaise modélisation pour un projet de construction : si il y a eu un problème pour poser les fondations, il y a peu de raisons de penser que le plombier aura aussi un problème.

⚠️ Beware! This is the metric that Microsoft Project calls EAC. This EAC is based on a VERY poor model for a software project.

The next best guess is that the total cost will be the BAC adjusted by the CPI. That is, if you are running over or under budget—remember, these are cumulative values over the project to date, not just what you did the last reporting period—you will probably be doing the same over the rest of the project:

\[
EAC = \frac{BAC}{CPI}
\]  
(A-2)

This model implies that the project’s performance will stay steady over time or, perhaps more accurately, that the project was consistently over- or underestimated. Murphy’s laws (Appendix C, #7) caution “Left to themselves, things tend to go from bad to worse.” In practice, “things” tend to get worse despite the project manager’s valiant attempts, or:

\[
EAC = \frac{ACWP + (BAC – BCWP)}{CPI}
\]  
(A-3)

The total project cost is the amount already spent plus the cost of the work still left to do, re-estimated based on the project’s performance to date. (You can also obtain this EAC from MS-Project’s by subtracting VAC [variance at completion] from the initial budget: that is, EAC = BAC_{MS-Project} – VAC_{MS-Project}.)

You may believe that (A-2) and (A-3) express the same thing since ACWP = BCWP/CPI. That is only true if you substitute the symbols into the equations, but not if we take their values over time into consideration. The value of CPI in each reporting period will change and usually decreases near the end of a project, when the “loose ends” suddenly show up.

Let’s continue the example of section A - 3. Assume that the project started on 1/31/2004 and was to end on 10/23/2004, and through 4/10/2004 we have obtained the results shown in Exhibit 6. Based on that performance, an EVA forecast for cost and schedule is shown in Exhibit 8 (page 18). Exhibit 6 tells us that as of 4/10/2004:

- The project has spent $14,880 (ACWP) to deliver a value of $12,480 (BCWP).
- The project still needs to deliver $56,160 – $12,480 = $43,680 in value.
- The project is only 83.9% cost-effective
- The Estimate at Completion (EAC) $66,960 instead of the budgeted $56,160.

The project started 1/24/2004 and was expected to finish 273 days later, on 10/23/2004, but we see from Exhibit 8 that as of 4/10/2004—77 days into the project—we are 3¾ days behind schedule. While it requires a few more assumptions, the remaining work probably will also be performed at the 95% (1 – 3.75 / 77) schedule efficiency. The project is, therefore, forecasted to end sometime during the 11/6/2004 reporting period instead of 10/23/2004.

The EVA status graph for our hypothetical project is shown in Exhibit 7. Note that these curves are much closer together than those in the illustration of Exhibit 3. (No reasonably managed project would be 6 months behind schedule after 18 months!)

---

6 The term Estimate to Completion (ETC) is often used for the fraction (BAC – BCWP) / CPI.
7 See Appendix Section B - 3, Forecast Steps, on the method used for calculating the future delivery dates.
**Exhibit 6 – Project Earned Value Analysis Summary**

<table>
<thead>
<tr>
<th>Status Date</th>
<th>Original Budget</th>
<th>Period</th>
<th>Project Performance</th>
<th>Forecast</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Exhibit 7 – Budget, Actual Cost and Estimate to Complete**

![Graph showing Earned Value Analysis](image-url)
<table>
<thead>
<tr>
<th>Delivery Dates</th>
<th>Original</th>
<th>Actual</th>
<th>Forecast</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BCWS</td>
<td>BCWP</td>
<td>ACWP</td>
</tr>
<tr>
<td>1/31/2004</td>
<td>2,400</td>
<td>1,714</td>
<td>2,400</td>
</tr>
<tr>
<td>2/7/2004</td>
<td>3,360</td>
<td>3,411</td>
<td>4,440</td>
</tr>
<tr>
<td>2/14/2004</td>
<td>4,440</td>
<td>4,440</td>
<td>5,400</td>
</tr>
<tr>
<td>2/21/2004</td>
<td>4,800</td>
<td>4,560</td>
<td>5,520</td>
</tr>
<tr>
<td>2/28/2004</td>
<td>5,520</td>
<td>5,520</td>
<td>6,840</td>
</tr>
<tr>
<td>3/13/2004</td>
<td>7,200</td>
<td>7,440</td>
<td>9,240</td>
</tr>
<tr>
<td>3/20/2004</td>
<td>8,640</td>
<td>8,240</td>
<td>10,320</td>
</tr>
<tr>
<td>4/10/2004</td>
<td>13,920</td>
<td>12,480</td>
<td>14,880</td>
</tr>
<tr>
<td>5/1/2004</td>
<td>16,800</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6/5/2004</td>
<td>24,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6/19/2004</td>
<td>26,280</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7/17/2004</td>
<td>34,080</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7/24/2004</td>
<td>34,920</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8/7/2004</td>
<td>39,240</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8/14/2004</td>
<td>40,800</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9/18/2004</td>
<td>50,400</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/2/2004</td>
<td>55,080</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/9/2004</td>
<td>55,080</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Exhibit 8 – Project Forecast Worksheet**

Optional date: 4/10/2004  
CPI: 83.87%  
Accomplished: $12,480  
Spent: $14,880  
SPI: 89.66%  
BAC: $56,160  
EAC: $66,960  
End date: 11/6/2004
The graph in Exhibit 7 was generated by the Project EVA worksheet. The dotted line is the time-phased approved budget (BCWS); the diamonds represent value of work performed (BCWP); and the heavy solid line is the actual expenditure (ACWP) to the left of the status date and the forecast (EAC column of Exhibit 8) of the expenditures to the right of the status date. (See Appendix B - 3, pg. 23 for details of the calculations.)

Also note in Exhibit 8 that the Period CVI allows you to quickly identify periods where a problem may exists. In the first few periods CVI will usually bounce around since most projects don’t start as smoothly as one might wish—unless startup activities are far more carefully planned than is customary (or practical) at UCLA. A few weeks into the project, however, performance should stabilize and outliers—whether determined through formal statistical processes or “eyeballing” the column of numbers—should be investigated. (It is assumed that emergent schedule problems are identified using the project scheduling program.)

A cautionary note on project managers’ “subjective” or “informed” forecasts.
Many project managers believe that can forecast a better ETC than one calculated by the computer. Don’t kid yourself! Experience shows that unless you are able to take drastic action, you are far more likely to hit (or exceed) a computer-generated EAC than one based on “professional judgment”…

The fact is, if the project was underestimated, it is likely consistently so and there is little you can do to change that. If project productivity is below expectation, you’ll have to change something in the delivery team. Doing that takes time and diverts resources.

Project managers tend to overestimate their ability to change fundamental behavior of a project, particularly in the early stages. Although it possible to make up for an early problem, it is usually very difficult to do in software development and even harder to prevent it from happening again. Unfortunately, today’s overly optimistic forecast is the seed from which your sponsor grows tomorrow’s disappointments…
APPENDIX B  EVA WITH MS-PROJECT AND EXCEL

This appendix gives a “recipe” to set up Microsoft Project and Microsoft Excel to perform earned value analyses and create the equivalent of Exhibit 7 and supporting data of Exhibit 6 and Exhibit 8 for your project. This appendix will assume that you have not modified tables and maps in Microsoft Project and use the template Project EVA available from http://www.oit.ucla.edu/Documents.

Note that to illustrate the concepts, the curves in Appendix A (e.g., Exhibit 2 and Exhibit 3) are shown widely spaced. In “real” projects they should be much closer together—don’t be alarmed if your graphics are less dramatic; in fact, you should be alarmed if they do look like the examples…

B - 1  Setup Steps

1)  Create the project plan in Microsoft Project as you would ordinarily do, noting the following:

a)  To reasonably control a project, your tasks should on average be no longer than the reporting interval. “Projects scheduled in days slip by days; scheduled in months, they slip by months.” Long duration effort-driven tasks are also prone to incorrect estimation and overruns. This is why scheduling algorithms—the MS Project resource leveler included—will schedule them early in the project; if they run into problems there may be time to fix them before the project due date.

b)  Create the tasks and tie them together with their absolute precedence dependencies. That is, when you define a task let it depend only on the immediate predecessor activities that must have been completed before the task starts.

Do not add precedence relationships to make the task sequence come out the way you want to. You will be fighting the tool: you will be doing all the work instead of the computer.

c)  Enter the resources for the project and their rates on the resource sheet and assign them to the tasks. Before you start, be sure that resource leveling is set to manual calculation: Tools -> Resource Leveling… then click the Manual radio button. Resource leveling is compute-intensive and “automatic” will give long delays after every change in your schedule.

Do not under ANY circumstances attach resources to a summary task—corollary: don’t promote resourced tasks! In some (all?) versions of Microsoft Project you will continue to count these resources even after you have “removed” them on the task form. (It is not clear if this is a bug or a feature, but either way you will spend hours trying to figure out why your projects don’t reconcile with your hand calculations.)

d)  Level the project’s resource utilization. (Verify that you use the correct scheduling method!)

e)  If you end up with problems in the schedule, think through the work breakdown logic and set constraints or change relative task priorities. Do NOT do this with “artificial” dependencies. The not in item b) above remains valid!

f)  Repeat d) and e) until you are satisfied.

2)  Calculate and capture the project baseline

a)  Once you (and your sponsors!) are satisfied with the project plan you want to calculate the project “baseline” (Tools -> Tracking -> Save Baseline…). This calculates the costs that will be used in the earned value analysis and saves it in the project file, but you still need to use (File->Save) to save the project file on disk.
b) Next you will prepare a file that will become the basis for the Project Summary workbook in Excel. This is the baseline for use in your subsequent analyses and graphics.

i) Go to View->More Views... and select Task Usage then Apply

ii) If necessary, collapse your project. You should have one or at most a few summary tasks.

iii) Go to Format->Details and select Cost. Deselect Work and anything else you may have displayed. You don’t want any other information to be brought into the worksheet.

iv) Adjust the timescale so the low tier corresponds to your reporting interval. (Right-click on the timescale.) Remember that the middle tier has to be set to an equal larger interval, so you may need to change that one first.

c) Click on the row(s) of data, and copy them to the clipboard.

3) Start Microsoft Excel with a blank worksheet. (These steps are a bit cumbersome, but they are pretty much fool proof. [See, however, item 11 on pg. 25.] While there are quicker ways to get data in the right format into the Project Summary, it is easy to destroy the worksheet formulas if you make a mistake. Be safe: you only need to do this once for a project.)

a) Go to cell A-1 and paste the information.

b) Select the data (not the entire rows) you have just copied and click on Copy. (Yes, you really need to do that!)

c) Place the cursor in column A of a row that is NOT highlighted.

d) Go to Edit -> Paste Special...

i) Select the All and None radio buttons

ii) Check the Transpose box

iii) Click OK.

(If you get an error, you may have used Cut instead of Copy or you selected the entire row, not the values in it.)

e) If you have multiple columns of data, sum (cross-foot) the rows.

f) Highlight the values in the only (or cross-foot) column and copy to the clipboard.

g) Open a new workbook from the Project EVA.xlt template.

h) Click in cell B3 of the Summary worksheet. Go to Edit->Paste Special, select the Values radio button, then click OK. (This preserves the formatting of the cells in the worksheet.)

i) Enter:

i) The first reporting date in cell A-3.

ii) The formula for the next reporting date in A-4 (e.g., =A3+14 for bi-weekly status reports).

iii) Replicate A-4 down the column for the remaining reporting dates.

j) This workbook is the “Project Summary.” Save it! You’re done until the end of the first status reporting period.
B - 2  Status Update Steps

At the end of each reporting period, you update your project schedule with actual status. These data must also be added to the Project Summary workbook.

1) **Update project status** in MS-Project with work actually accomplished. Use one of the methods in **Tools -> Tracking** or use the tracking wizard.
   a) **Do not save a new baseline.** That option only gets used when you have an approved budget or schedule change. You are held accountable for the approved schedule and until a new budget and schedule is approved the baseline does not change.
   b) Entering actual work performed and estimate to complete is far superior to entering a “percent complete” for a task: this is how projects get stuck at 85% complete until they get cancelled…

2) **Save your updates.** Unless you never make mistakes, it is a good practice to **save the file under a different name** (**File -> Save As…** or function key **F12**). It is easier to “debug” a problem in your schedule if you can look at last week’s status than if you have overwritten that file. A good way is to include the status date in the name: if you use the form **YEAR-MONTH-DAY** the files can easily be sorted into sequential order.

3) **Export earned value data in Excel format.** (Unfortunately, this process far from intuitive!)
   a) In MS-Project go to **File -> Save as web page.** *Do NOT use the “Publish project information to the web” option of the tracking wizard.* (This option publishes information to a collaborating team if you have the server edition of MS-Project, but it will not export the EVA data to an Excel worksheet.)
   b) Select the directory where you want to store the project data and select **Microsoft Excel Workbook** from the “Save as type” drop-down box, then click on **Save.** This starts the “Export Wizard.”
      i) Click Next to continue with the wizard.
      ii) Use the **Selected Data** radio button (the default) and click Next.
      iii) Change the radio button to **Use existing map.**
      iv) Click **Next** and select **Earned value information.**
          (At some time in the future you may decide that you want to create your own data map to export additional data, but for now use the built-in one.)
      v) Click **Next.** Do **NOT use Finish** unless you have created your own map. You will get all the task details, too.
      vi) Mark ONLY the checkboxes for **Tasks** and **Export includes headers.**
      vii) Click **Next.** Again, **do NOT click Finish!**
      viii) Select **Summary Tasks** from the Export Filter drop-down. The purpose is to get the least amount of extraneous information into the Excel file—the more data, the more work you’ll have trying to pick out the values you need.
          • If you have a single task in your schedule that rolls up the entire project use **“Task Range…”** and you will be prompted for the task number range. Enter the number of that summary task as both the first and last task in the range.

---

8 Rebaselining the project also requires making changes in the baseline saved in the Project Summary. These changes are not further discussed in this appendix.
ix) If you want to save these settings, click **Next**, otherwise click **Finish**. (Be sure to save the Project file again if you saved these settings as a new map.)

4) Open the Project Summary workbook that you created during the setup steps.

5) Open the Excel file that MS Project just created in step (3). It should give you the task ID and name for all summary tasks plus their BCWS, BCWP, ACWP, SV, CV, EAC, BAC and VAC values. These are the values that you want to add to your Project Summary.

   a) If you have more than a single data row on this worksheet, create a new row with the sum of the proper rows that make up the **total** budget. You’ll have to make sure that only “true” summaries are included in the sum. That is, no row that is rolled up into a row above it should be included. This new row represents the results of the current reporting period.

   b) Move the current worksheet into the Project Summary. If you put it right after the **Time-sheet Data** worksheet and before any other status sheets, the most recent sheet is visible without having to search through the entire set. You’ll thank us after about 12 or so reporting periods…)

   c) Rename the copied sheet from “Earned Value,” preferably to something that identifies the status date. (After a handful of updates, you’ll be glad you did!)

   d) Highlight the **values**, **NOT the row**, for the current reporting period and copy them.

   e) Use **Paste Special** and the **Values** radio button to put them into the **B** column of the **Project Data** worksheet for the next status date. (This will preserve the formatting of the cells in the worksheet.)

   f) If you use actual cost data from a job costing system, transfer that information to **Time-sheet Data** worksheet. You can either enter the total period cost in column **D** or enter individual timesheets in columns **D** through **IV**. The worksheet will calculate the sum of the timesheets and the project ACWP and carry these values forward into the summary.

      • The ACWP in **Project Data** (from the exported file) is based on “standard” cost; the job costing system will use “actual” cost. The worksheet allows you to track labor variances: the difference between the cost of the resource you had planned to use and the one who actually did the work. The Summary worksheet has a Labor Cost Index (LCI =ACWP\textsubscript{Standard}/ACWP\textsubscript{Actual}). This column will only have values if you use timesheet data. LCI < 1 means labor is more expensive than standard rate—less work was done for the same dollars.

      • You can switch to start using timesheet data at any time, but once you start you cannot stop. Your forecasts (EAC) will be bad unless you (1) erase all previous timesheet entries, or (2) modify the worksheet formulae.

**B - 3 Forecast Steps**

The Project Summary workbook contains a **Forecast Tabular** worksheet that makes projections to generate the “Cost, Schedule and Forecast” graphics (see Exhibit 7, pg. 17). No input is required to forecast based on the latest information, but you can base the analysis on any date (after project inception) by entering that date in cell **B1**.

The EVA graph corresponding to this forecast is on a separate worksheet (**Graph**) to facilitate its incorporation into presentations, etc. Most likely manual formatting of the graph is required to display all information, get sensible values along axes, change range of data displayed, etc. The ACWP line is shown in a faint yellow, because the line smoothing for the historic ACWP is different than for EAC. (You may want to turn line smoothing off and choose a different line property or omit ACWP.)
The **Original** columns on **Forecast Tabular** are copied from the project baseline in **Summary**. The **Actual** BCWP, ACWP and CVI columns fill in as you enter period results. The **forecast** EAC and delivery dates are calculated. (EAC copies all historic ACWP data to facilitate generating the graphics, but see the note above about smoothing, etc.)

The first 10 data points are plotted by default on the graphics page. Initially this will result in ACWP points along the X-axis as well as well as smoothed curves that undershoot the X-axis. You can edit the Series to correct these problems in the way that they meet your needs. Likewise, once you have more than 10 periods of data, or if you want to display the entire duration of project, you must adjust the data series.

The work expected to be performed (the time-phased EAC) in each period (i) is calculated from status date data by:

\[ EAC_i = ACWP_{\text{Status}} + (BCWS_i - BCWP_{\text{Status}}) / CPI_{\text{Status}} \]  

(B-1)

The project’s Estimate at Completion (EAC) = ACWP_N where “N” equals the period in which the project will complete.

The far more complex problem is estimating the “delivery dates,” a forecast of when the remaining work is expected to complete. Put differently, how do we draw a forecast of the BCWP curve? Or, how can we derive the BCWP curve from the BCWS curve and current project performance. Although we can calculate a point estimate (EAC), we do not have enough information to predict the project’s future more granularly: the slope of the BCWP curve varies from that of the BCWS curve, which itself is not constant.

An equation analogous to (B-1) using dates and the SPI metric would provide one estimate. An alternative is based on the Labor Productivity Index (LPI)—the ratio of scheduled to expended labor hours—a metric most project managers already track. If Date_{\text{Status}} is the status date, Date_{\text{BCWP}} the date that the BCWS_{\text{Status}} work should have been completed (on the original schedule), Date_0 the project start date, and Date_{Fi} the date that BCWS_i of period (i) is forecasted to be actually completed, then

\[ Date_{Fi} = Date_{\text{Status}} + (Date_{\text{BCWSi}} + (Date_{\text{Status}} - Date_{\text{BCWP}}))/LPI_{\text{Status}} \]  

(B-2)

where \[ LPI_{\text{Status}} = (Date_{\text{BCWP}} - Date_0) / (Date_{\text{Status}} - Date_0) \]  

(B-3)

Obviously this forecast cannot take the fine details of the schedule into consideration. For example, if a hiatus in work represents a scheduled down time or the schedule has free float because of external dependencies, this is not taken into consideration in the forecast.

The built-in forecast assumes that the relative schedule efficiency will remain consistent. That is, the remaining work will actually be performed as much later or earlier as the work to date has been done. Note, though, that if the project works 5 days per week and it is 5 working days behind schedule, the project will be 7 days behind schedule in calendar time.

As an alternative one can use the purely financial metric SPI_{\text{Status}} to compute new delivery dates. This metric will give different results depending on the slope of the BCWS curve. Giving it has far more intuitive appeal. (The **Project EVA** template can be modified to use CPI.)

Although all worksheets cells with formulae are “protected” to prevent you from accidentally damaging equations in cells that look like they are empty, there are no passwords on any of the sheets. Use **Tools->Protection->Unprotect Sheet** to unlock the worksheets.

When the discrepancies become too great—that is, the project is in serious trouble—it must ultimately be redirected and rebaselined. A discussion of the possible ways to represent such drastic changes requires modifying the logic of the worksheets and is beyond the scope of this appendix.
APPENDIX C  MURPHY’S LAWS

AIR FORCE FLIGHT TEST CENTER LORE
According to http://www.edwards.af.mil/history/docs_html/tidbits/murphy's_law.html “Murphy's Law ("If anything can go wrong, it will") was born at Edwards Air Force Base - in 1949 at North Base. It was named after Capt. Edward A. Murphy, an engineer working on Air Force Project MX981, a project designed to see how much sudden deceleration a person can stand in a crash.

“One day, after finding that a transducer was wired wrong, he cursed the technician responsible and said, 'If there is any way to do it wrong, he'll find it.' The Northrop project manager, George E. Nichols, had a few laws of his own and added this one, which he called Murphy’s Law. Nichols is still around [March 1978 when the article was written] at NASA's Jet Propulsion Lab in Pasadena, where he is the quality control manager for the Viking project to send an unmanned spacecraft to Mars.”

ÉCOLE POLYTECHNIQUE FÉDÉRALE DE LAUSANNE
The Institut de Mathématiques of the EPFL maintains a site with some 65 pages of Murphy’s Laws, corollaries and “extensions” at http://dmawww.epfl.ch/roso.mosaic/dm/murphy.html. If for no reason other than its sheer bulk ☺, it must be considered an authoritative source for Murphiana:

1. Nothing is as easy as it looks.
2. Everything takes longer than you think.
3. Anything that can go wrong will go wrong.
4. If there is a possibility of several things going wrong, the one that will cause the most damage will be the one to go wrong.
   Corollary: If there is a worse time for something to go wrong, it will happen then.
5. If anything simply cannot go wrong, it will anyway.
6. If you perceive that there are four possible ways in which a procedure can go wrong, and circumvent these, then a fifth way, unprepared for, will promptly develop.
7. Left to themselves, things tend to go from bad to worse.
8. If everything seems to be going well, you have obviously overlooked something.
10. Mother Nature is a bitch.
11. It is impossible to make anything foolproof because fools are so ingenious.
12. Whenever you set out to do something, something else must be done first.
13. Every solution breeds new problems.
APPENDIX D  THE PROJECT ANALYZER

The Software Program Managers Network (www.spmn.org) publishes various management review tools, among which is a checklist, the Project Analyzer—familiarly known as the “Little Red Book.” It was developed by an advisory group of software development methodology “heavies,” the Airlie Software Council, as a set of questions that any project managers should be prepared to answer.

THE AIRLIE SOFTWARE COUNCIL

Victor Basili — University of Maryland
Grady Booch — Rational Software (Now part of IBM)
Norm Brown — Software Program Managers Network
Peter Chen — Chen & Associates, Inc.
Christine Davis — Texas Instruments
Tom De Marco — The Atlantic Systems Guild
Mike Dyer — Lockheed Martin
Mike Evans — Computers & Concepts Associates
Bill Hetzel — Qware
Capers Jones — SPR Inc.
Tim Lister — The Atlantic Systems Guild
John Manzo — 3 Com
Lou Mazzucchelli — Gerard Klauer Mattison & Co., LLC
Tom McCabe — McCabe & Associates
Frank McGrath — Software Focus, In c.
Larry Putnam — Quantitative Software Management
Howard Rubin — Hunter College, CUNY
Ed Yourdon — American Programmer
The Project Analyzer questions provide program managers with a “quick look” at software project health. They identify software projects that should not be on the road. The Project Analyzer determines whether key program elements exist, without which the program is not likely to succeed. If a program manager cannot answer these questions about current project status, or must answer a question in the negative, then the project should be scheduled for immediate review.

The Airlie Software Council of software experts and industry leaders constructed these questions under the aegis of the Software Program Managers Network.

We would appreciate any comments or suggestions you have (e-mail: spmn@aol.com).

Norm Brown
Executive Director
If a program manager cannot answer the following questions about current project status, or must answer in the negative, then the project should be scheduled for immediate review:

1. Do you have a current, credible activity network supported by a Work Breakdown Structure (WBS)?
2. Do you have a current, credible schedule and budget?
3. Do you know what software you are responsible for delivering?
4. Can you list the current top ten project risks?
5. Do you know your schedule compression percentage?
6. What is the estimated size of your software deliverable? How was it derived?
7. Do you know the percentage of external interfaces that are not under your control?
8. Does your staff have sufficient expertise in the project domains?
9. Have you identified adequate staff to allocate to the scheduled tasks at the right time?
An activity network is the primary means to organize and allocate work.

1. Have you identified your critical path items?
2. What explicit provisions have you made for work that isn’t on your WBS?
3. Does the activity network clearly organize, define, and graphically display the work to be accomplished?
4. Does the top-level activity network graphically define the program from start to finish, including dependencies?
5. Does the lowest-level WBS show work packages with measurable tasks and short duration?
6. Are project objectives fully supported by lower-level objectives?
7. Does each task on the network have a well-defined deliverable?
8. Is each work package under budget control (expressed in labor hours, dollars, or other numerical units)?

A well-constructed activity network results in accurate estimates for project time, cost, and personnel needs as estimates begin with specific work packages.

NOTE

1. DO YOU HAVE A CURRENT, CREDIBLE ACTIVITY NETWORK SUPPORTED BY A WORK BREAKDOWN STRUCTURE (WBS)?
2. DO YOU HAVE A CURRENT, CREDIBLE SCHEDULE AND BUDGET?

1. Is the schedule based on a project/activity network supported by the WBS?
2. Is the schedule based on realistic historical, quantitative performance estimates?
3. Does the schedule provide time for education, holidays, vacations, sick leave, etc.?
4. Does the schedule provide time for Quality Assurance (QA) activities?
5. Does the schedule allow for all interdependencies?
6. Does the schedule account for resource overlap?
7. Is the schedule for the next three to six months as detailed as possible?
8. Is the schedule consistently updated at all levels on Gantt, PERT, and Critical Path charts every two weeks?
9. Is the budget clearly based on the schedule and required resources over time?
10. Can you perform to the schedule and budget?

3. DO YOU KNOW WHAT SOFTWARE YOU ARE RESPONSIBLE FOR DELIVERING?

1. Are system operational requirements clearly specified?
2. Are definitions of what the software must do to support system operational requirements clearly specified?
3. Are system interfaces clearly specified and, if appropriate, prototyped?
4. Is the selection of software architecture and design method traceable to system operational characteristics?
5. Are descriptions of the system environment and relationships of software application to the system architecture specified clearly?
6. Are specific development requirements explicitly defined?
7. Are specific acceptance and delivery requirements explicitly defined?
8. Are user requirements agreed to by joint teams of developers and users?
9. Are system requirements traceable through the software design?
4. CAN YOU LIST THE CURRENT TOP TEN PROJECT RISKS?

1. Has a full-time Risk Management Officer been assigned to the project?
2. Are risks determined through established processes for risk identification, assessment, and mitigation?
3. Is there a database that includes all non-negligible risks in terms of probability, earliest expected visible symptom, estimated and actual schedule, and cost effects?
4. Are all project personnel encouraged to become risk identifiers? Is there an anonymous communications channel for transmitting and receiving bad news?
5. Are correction plans written, followed up, and reported?
6. Is the database of top ten risk lists updated regularly?
7. Are transfers of all deliverables/products controlled?
8. Are user requirements reasonably stable?
9. How are risks changing over time?
1. Has the schedule been constructed bottom up from quantitative estimates, not by predetermined end dates?

2. Has the schedule been modified when major modifications in the software have taken place?

3. Have programmers and test personnel received training in the principal domain area, the hardware, support software, and tools?

4. Have very detailed unit-level and interface design specifications been created for maximum parallel programmer effort?

5. Does the project avoid extreme dependence on specific individuals?

6. Are people working abnormal hours?

7. Do you know the historical schedule compression percentage on similar projects, and the results of those projects?

8. Is any part of the schedule compression based on the use of new technologies?

9. Has the percent of software functionality been decreased in proportion to the percent of schedule compression?

Schedule Compression Percentage = \[1.00 - \left(\frac{\text{Calendar Time Scheduled}}{\text{Nominal Expected Time}}\right)\] \times 100

Nominal Expected Time is a function of total effort expressed in person months. For example, Boehm\(^1\) found that:

For a class of DoD project of 500 person months or more, Nominal Expected Time = 2.15 \times (Expected Person Months)\(^{0.33}\). Nominal Expected Time was measured from System Requirements Review to System Acceptance Test.

Attempts to compress a schedule to less than 80 percent are not usually successful. New technologies are an additional risk in time and cost.

6. WHAT IS THE ESTIMATED SIZE OF YOUR SOFTWARE DELIVERABLE? HOW WAS IT DERIVED?

1. Has project scope been clearly established?
2. Were measurements from previous projects used as a basis for size estimates?
3. Were Source Lines of Code (SLOC) used as a basis for estimates?
4. Were Function Points (FPs) used as a basis for estimates?
5. What estimating tools were used?
6. Are the developers who do the estimating experienced in the domain area?
7. Were estimates of project size corroborated by estimate verification?
8. Are estimates regularly updated to reflect software development realities?

NOTE: Software size estimation is a process that should continue as the project proceeds.

7. DO YOU KNOW THE PERCENTAGE OF EXTERNAL INTERFACES THAT ARE NOT UNDER YOUR CONTROL?

1. Has each external interface been identified?
2. Have critical dependencies of each external interface been documented?
3. Has each external interface been ranked based on potential project impact?
4. Have procedures been established to monitor external interfaces until the risk is eliminated or substantially reduced?
5. Have agreements with the external interface controlling organizations been reached and documented?
8. Does the staff have sufficient expertise in the key project domains?

1. Do you know what the user needs, wants, and expects?
2. Does the staffing plan include a list of the key expertise areas and estimated number of personnel needed?
3. Does most of the project staff have experience with the specific type of system (business, personnel, weapon, etc.) being developed?
4. Does most of the project staff have extensive experience in the software language to be used?
5. Are the developers able to proceed without undue requests for additional time and cost to help resolve technical problems?
6. Do the developers understand their project role and are they committed to its success?
7. Are the developers knowledgeable in domain engineering—the process of choosing the best model for the project and using it throughout design, code, and test?
8. Is there a domain area expert assigned to each domain?

9. Have you identified adequate staff to allocate to the scheduled tasks at the scheduled time?

1. Do you have sufficient staff to support the tasks identified in the activity network?
2. Is the staffing plan based on historical data of level of effort or staff months on similar projects?
3. Do you have adequate staffing for the current tasks and all the tasks scheduled to occur in the next two months?
4. Have alternative staff buildup approaches been planned?
5. Does the staff buildup rate match the rate at which the project leaders identify unsolved problems?
6. Is there sufficient range and coverage of skills on the project?
7. Is there adequate time allocated for staff vacations, sick leave, training, and education?
8. Are staffing plans regularly updated to reflect reality?
## INDEX

**A**
- Action item ........................................... 5, 6, 7, 11
- Adjourned session ................................ 7, 11

**B**
- Briefing book ........................................... 8, 10, 11
- Budget ..................................................... 1, 2, 4, 5, 12, 13, 14, 15, 16, 19, 22, 23

**C**
- Chairperson ............................................. See Moderator of the ITPB
- CITI (Committee on Information Technology Infrastructure) ........................................... 2
- CSG (Common Systems Group) ...................... 2

**D**
- Deliverables ............................................... 5, 6, 9, 12, 13

**E**
- Earned value analysis .................................. 1, 5, 9, 12, 14, 15, 16, 19, 20, 21, 22, 23, 24
- Emergency review ...................................... 7
- EVA ....................................................... See Earned value analysis

**H**
- Handouts .................................................. See Briefing book

**I**
- Information Technology Planning Board ............ 1, 2, 6
  - Issues
    - Institutional – addressed by project ........ 3
    - Raising – not on the agenda ................. 2, 3, 11
    - Resolution of significant ..................... 5
    - Stakeholder’s ..................................... 6
    - Technical .......................................... 4
    - Technology ....................................... 2
- ITPB ....................................................... See Information Technology Planning Board

**L**
- Lifecycle model ......................................... 4, 8

**M**
- Meeting minutes ....................................... See Minutes
  - Milestones ............................................ 5, 9
  - Minutes ................................................ 1, 3, 5, 7
  - Moderator .............................................. 3, 7, 11
  - Murphy's Laws ....................................... 16, 25

**O**
- OIT (Office of Information Technology) ............ 1, 2, 3, 7, 11

**P**
- PCD ....................................................... See Project Control Document
- Peer institutions ....................................... 4
- Project Control Document .......................... 1, 6, 7, 8, 9
- Project Development Flow process .................... 1
- Project Manager ....................................... 1, 2, 3, 5, 6, 7, 9, 10, 11, 12, 13, 15, 16, 19, 24, 26
- Project Notebook ..................................... 3, 7
- Project Reviewer ...................................... 1, 5, 7, 8, 10, 11, 15

**R**
- Recording secretary ................................... 3, 7

**S**
- Shutdown plan ......................................... 6
- Software Program Managers Network ............... 26
- Stakeholder ............................................. 2, 4, 5, 6, 7, 8, 9, 11

**T**
- Template
  - MS-Excel ............................................. 1, 9, 20, 21, 24

**U**
- Updates
  - to PCD ............................................... 8
- Urgency
  - Level of ............................................ 5

**W**
- Website
  - CSG .................................................... 2
  - Murphy's Laws ...................................... 25
  - OIT .................................................... 1
  - Project ............................................... 8
  - SPMN ................................................... 26